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Overview 
 
In the previous article you learned how to take the initial measurements of your Left and Right 
speakers using the Room EQ Wizard (REW). 
 
In this article you will learn how to measure your speakers using Acourate, analyze the measured 
Impulse Response curves, design a Target Curve and run through a series of Macros to generate 
a set of FIR Filters that would add corrections to the Amplitude and Time domains. 
 
In the next article you will learn how to import these FIR Filters into ROON’s Convolution Engine.  
 
Acourate is the most advanced and feature rich Digital Room Correction software available 
today. With a myriad of functions offering a granular level of control, this is the professional’s 
choice.  
 
This software has been designed by Dr. Ulrich Brüggemann 
 
 

Purchasing an Acourate License 
 
The easiest way to obtain an Acourate license for personal use is to contact Dr. Brüggemann 
directly via email uli.brueggemann@gmail.com 
 
You may also fill out this contact form: 
 
https://www.audiovero.de/en/contact-form.php 
 
The price is about $520. 
 
These are the hardware requirements: 
 
https://www.audiovero.de/en/system-requirements.php 
 
Acourate licenses are tied to your CPU. 
 
You must generate an ACOURATE ID for the device you plan to run this software. 
 
To do this you need to run AcourateIDv3.exe 
 

 

https://www.audiovero.de/en/acourate.php
mailto:uli.brueggemann@gmail.com
https://www.audiovero.de/en/contact-form.php
https://www.audiovero.de/en/system-requirements.php
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You can download AcourateIDv3.exe from the Downloads page: 
 
https://www.audiovero.de/en/downloads.php 
 
Login = Guest 
Password = five 
 

 
 
Running AcourateIDv3.exe will generate a text file with a unique Acourate ID.  
 
Email this text file back to Dr. Brüggemann when you are ready to purchase a license. Uli will 
create AcorateSetup64.exe authorized to run on your device. 
 

 
 
Install this program on your device and you are ready to go. 
 
Note: To switch this license to a different device you must contact Uli. You can switch devices up 
to 3 times. 

https://www.audiovero.de/en/downloads.php
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Here is an example of an Acourate ID. 
 

 
 
After installation, the License Information will appear under the Help Menu. 
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Downloading an Acourate Trial Version 
 
You can download the Acourate Trial Version from the Downloads page:  
 
https://www.audiovero.de/en/downloads.php 
 
Login = Guest 
Password = five 
 

 
 
The Trial Version is valid for 14 days. You cannot generate Filters. 
You can examine all the features and functions while referencing the Online User Guide: 
 
https://www.audiovero.de/acourate-wiki/doku.php?id=en:start 
 

 

https://www.audiovero.de/en/downloads.php
https://www.audiovero.de/acourate-wiki/doku.php?id=en:start
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You will quickly discover that purchasing a personal license to run Acourate from Dr. Ulrich 
Brüggemann is a very different experience from buying a commercial product. 
 
Uli takes personal interest on your specific needs from the very first day you initiate contact. He 
will continuously guide you at every step. On the very first day he sent me links to a collection of 
articles and how-to guides to get me started. He even made useful suggestions looking at 
pictures of my setup. 
 
Acourate is a complex tool designed for professionals. This software is a tweakers delight. One 
can spend weeks and months fine-tuning their 2-channel audio setup exploiting the power of 
Acourate to arrive at the best frequency response curve to match one’s musical tastes.  
 
Uli has made the software easy to use for beginners by providing a set of Macros that walk you 
through all the essential steps. Simply using the default settings in these Macros would lead to 
good results in your very first iteration. Later as you become more experienced you can modify 
the default settings to achieve even better results specific your situation. 
 
In this section you will learn how to start from scratch with a new Acourate Project Workspace 
and Generate a FIR Filter as your first iteration. 
 
Let’s begin! 
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Create an Acourate Project Workspace 
 
Create a Folder named ACOURATE on your hard drive to hold all your Project Workspaces. 
 
C:\ACOURATE 
 
Within this folder create a new folder named P1 
 
C:\ACOURATE\ 
 

 
 
All the files that you would be creating for this Project will reside under this folder P1. 
 
C:\ACOURATE\P1 
 
P1 will be the name of your first project. 
You can name subsequent project workspaces as P2, P3, P4, etc. 
 
The file structure would look like: 
 
C:\ACOURATE\ 
P1 
P2 
P3 
P4 
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Copy the Microphone Calibration file into your Project Workspace 
 
Copy 33587.txt into C:\ACOURATE\P1 
 

 
 
This is all you need to get stated. 
 

Launch Acourate Version 3 
 
Launch the program by clicking the Acourate PRO64 V3 Desktop Icon. 
 

 
 
Be patient! It will take a while to load. 
This will be your initial screen. 
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Examine the Acourate User Interface 
 
At the bottom right you will find the Acourate version you are using. 
The latest version is 3.16 as of 5/11/2025. 
 

 
 
All the available functions are listed on the top. 
 

 
 
Open the File Menu 
 

 
 
To keep matters simple, only the commands highlighted in green will be used during this first 
Project P1. 
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Open the Edit Menu 
 

 
 
Open the View Menu 
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Open the TD-Function Menu 
 
These are all your Time Domain Functions. 
 
You will be using only the top 2 highlighted in green. 
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Open the FD-Functions Menu 
 
These are you Frequency Domain Functions. 
 
You will be using only 3 that are highlighted in green. 
 

 
 
 
 
 
Open the Crossover Menu. 
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Open the Recording Menu 
 
You will be using only the first 2 highlighted in green. 
 

 
 
 
Open the Room Menu 
 
You will be running the Room Macros 0 through 6 
 

 
 
As a shortcut these macros can be invoked by pressing these buttons numbered 0 through 6.  
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Open the Generate Menu 
 

 
 
 
 
 
Open the FIR-Functions Menu 
 

 
 
 
 
Open the Help Menu 
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As you can see from the list of available functions, this tool has been designed for professionals. 
 
In this exercise you would be using only a few of the functions highlighted in green and use the 
Macros with their default settings for this initial test Project P1. 
 
 

Select Project Workspace Directory 
 
File > Select/Create Project Workspace Directory 
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Select P1 
 

 
 
OK 
 
Notice, how Acourate displays the selected Workspace = C:\ACOURATE\P1 
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Open Windows Explorer and view the contents of: 
 
C:\ACOURATE\P1 
 

 
 
You will see that Acourate has created 2 new files. 
 
Acourate.ini  
 
[Access] 
LastSaveDir=C:\ACOURATE\P1\ 
 
 
AcourateHistory.txt 
 
#1;SetWorkspace;C:\ACOURATE\P1\ 
 
 
These two files keep track of every operation you execute within Acourate. 
If you ever want to revisit your past Acourate Projects and find what Parameters you had used, 
these are the two files you would need to examine. 
 

Set Sample Rate to 48,000 Hz 
 
The default Sample Rate is 48,000 Hz. Keep this default. 
You would be using the same sample rate throughout this Project. 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
18 

 

Import Magnitude  
 
File > Import > Import Magnitude (Mic Calibration or Target Curve) 
 

 
 
Select the Mic Calibration File 33587.txt 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
19 

Select the default Pulse Length = 65536 
 

 
 
Note: Whenever you see such a choice list, always pick the default or the highest value. 
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This is the graphical representation of your Mic Calibration file 33587.txt 
 

 
 
On the right of the plot you will find the Curve Legend 
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Acourate allows you to load a maximum of 6 Curves at a time. 
 

 
 
While you can have up to 6 Curves loaded, only 1 Curve can be Active at a time. 
 
To make a Curve Active, select its corresponding Radio Button. 
 
When you execute a function, it applies to the Curve that is Active. 
 
In this example, Curve 1 is Active. 
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Save this Microphone Calibration Curve. 
 
Click on the Save Icon 
 
This will save the Active Curve 
 

 
 
 
Name this file EMM-6 Mic Calibration 
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The Curve Legend will show the new name. 
 

 
 
 
 
Examine the contents of: 
 
C:\ACOURATE\P1 
 

 
 
The EMM-6 Mic Calibration.dbl file has been saved to your Project Workspace. 
 
 
 
Open AcourateHistory.txt 
 
Step #4 shows that you have saved the file as EMM-6 Mic Calibration.dbl 
 
#1;SetWorkspace;C:\ACOURATE\P1\ 
#2;SetSamplerate;rate=48000 
#3;ImportMagnitude;to=1;filename=C:\ACOURATE\P1\33587.txt;length=65536,minphase=1 
#4;SaveFile;of=1;filename=C:\ACOURATE\P1\EMM-6 Mic Calibration.dbl 
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Invert the Mic Calibration Curve 
 
Your objective is to invert the Mic Calibration Curve. 
 
Make sure Curve 1 is Active 
 

 
 
 
 
FD-Functions > Magnitude Inversion 
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Select Minimum Phase. This is the default. 
 
Select Curve 2. This will place the results of the Inversion into Curve 2. 
 

 
 
Calculate Inversion 
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The green curve is your Inverted Curve. 
 

 
 
The Legend will show the Inverted Curve in green. 
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You are going to Save the Inverted Curve as EMM-6 Inverted 
 
Make sure Curve 2 is Active 
 

 
 
 
 
 
 
Click on the Save Icon. 
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Name the Inverted Curve = EMM-6 Inverted 
 

 
 
 
 
Save 
 
The Legend will display the saved name = EMM-6 Inverted 
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Save the Inverted Curve to a Mono WAV file 
 
Make sure Curve 2 is Active 
 

 
 
 
 
 
File > Save Mono WAV 
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Save 
 
Select 64: double float [default] 
 

 
 
Note: Always select the default or the highest value. 
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You will get this confirmation dialog. 
 

 
 
View the contents of C:\ACOURATE\P1 
 

 
 
You will see the new EMM-6 Inverted.wav file in your Project Workspace. 
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Microphone Alignment 
 
Orient the Microphone horizontally at the listening position at ear height. 
 
It should not be pointed to the Left or the Right speaker but rather straight ahead on axis as 
shown in this diagram. The microphone should remain fixed at this position throughout the 
duration of this Project. 
 

 
 
Ideally, the listening position should form an equilateral triangle for best imaging.  
 
At the very least, the listening position should be equidistant from the Left and Right speakers. 
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Now you are ready to precisely align your Microphone. 
 
It must be exactly on axis at the same distance from the Left and Right speakers.  
 
Recording > Microphone Alignment 
 

 
 
 

 
 
Start MicAlign 
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Watch the arrow. It will tell you which way you need to move your microphone. 
 

 
 
Move the Microphone a bit to the right. 
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Move the Microphone a bit to the Left 
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Your Microphone will be perfectly aligned when the reading shows a green zero. 
 

 
 
Stop MicAlign 
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LogSweep Recorder 
 
Recording > LogSweep Recorder 
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Select Mic Calibration = EMM-6 Inverted.wav 
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Reduce the Output Volume from 0dB (Default) to -12dB. 
This matches the default Output Volume in REW. 
 
 

 
 
Note: It is a good idea to play the LogSweep at roughly the same level you use for music playback 
for example around 80dB. 
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Start Recording 
 

 
 
You need to stay absolutely quiet as it sweeps the Left Channel followed by the Right Channel.  
 
Turn off the Air Conditioner.  
Turn off anything that may be creating any external noise. 
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Recording in progress. 
 

 
 
An Information screen will appear at the end showing how good your Interchannel Cross 
Correlation is. 
 

 
 
Press OK
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Two new curves will appear. 
 

 
 
Examine the Legend 
 

 
 
Curve 1 = Pulse48L = Measured Impulse Response of the LEFT Channel shown in red. 
 
Curve 2 = Pulse48R = Measured Impulse Response of the RIGHT Channel shown in green.  
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View the contents of the Project Workspace P1 
 
C:\ACOURATE\P1 
 
You will find the LogSweep Recording of the Left and Right Channels in WAV format.  
 

 
 
You will find the Measured Impulse Response of the Left and Right Channels. 
 

 
 
Before you proceed to apply any digital corrections, let’s examine the problem areas in your 
Measured Impulse Response curves. 
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Examine the Measured Impulse Response curves 
 
First, you will examine the Left Channel. 
 
Uncheck Pulse48R in the Legend 
 

 
 
 
You are viewing the Measured Impulse Response of the Left Channel in red. 
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Let’s say you want examine the Region between 100Hz and 1000Hz. 
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Left Click on the Left Boundary of your Region. 
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Right Click on the Right Boundary of your Region. 
 

 
 
Your Region is now defined. 
 
Click on the Zoom In Tool 
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This is your Measured Impulse Response of your Left Channel between 100Hz and 1000Hz.  
 

 
 
 
To go back to the full scale view, click on the Zoom Out Tool. 
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This is your full scale view. 
 

 
 
 
You can define any Region with your Left and Right mouse clicks and zoom in using the Zoom In 
Tool. 
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You can drag the boundaries to resize an existing Region. 
 

 
 
Zoom In 
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You can remove the Left and Right Markers by clicking on Clear Markers Tool. 
 

 
 
To better visualize what is going on, it is always a good idea to apply some smoothing. 
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Select Curve 1 = Pulse48L as the Active Curve. 
 

 
 

 
 
 

 
 
Click on the Draw Active Curve with a Fat Line Tool. 
 
This is another way to visually verify which curve is currently Active. 
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TD-Functions > Psychoacoustics 
 

 
 
You are going to apply a Psychoacoustic Smoothing to Curve 1 and place the results of the 
smoothing into Curve 3. 
 
Select Psychoacoustic  
Select Curve 3 
 

 
 
Compute PSY 
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The brown curve is the result of applying Psychoacoustic smoothing to Curve 1. 
 

 
 

 
 
Uncheck Pulse48L 
 
This gives you a better picture of the Measured Impulse Response of the Left Channel.  
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Save this curve. 
 

 
 
Name the File L Before Psy and Save 
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Repeat the same steps for the Right Channel. 
 
Show Curve 2 = Pulse48R 
Hide all others 
 

 
 
Make Curve 2 Active 
 

 
 
 
TD-Functions > Psychoacoustics 
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Select Psychoacoustics 
 
Place the Results in Curve 4 
 

 
 
Compute PSY 
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Show Curve 4 
Hide everything else. 
 

 
 
Make sure Curve 4 is Active 
 

 
 
Save this Curve 
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Name the File R Before Psy and Save 
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View the contents of your Project Workspace P1 
 

 
 
You will find the two new files you just created: 
 
L Before Psy.dbl 
R Before Psy.dbl 
 
These are the results of apply Psychoacoustics smoothing to the Measured Impulse Response of 
the Left and Right Channels. 
 
Next, you are going to apply a 1/6th Octave Smoothing to Pulse48L and Pulse48R. 
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Show Curve 1 = Pulse48L 
 

 
 
Make Curve 1 Active 
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Select 1/6 Octave Analysis 
 
Place the results in Curve 5 
 

 
 
Compute PSY 
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Hide Pulse48L 
 
Make sure only Curve 5 is turned on. 
 

 
 

 
 
Make sure Curve 5 is Active 
 

 
 
Save this Curve 
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Name the File L Before 1-6 Oct and Save 
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This is the measured impulse response of the LEFT Channel after applying 1/6 th Octave 
smoothing. 
 

 
 
 
This should be similar to what you get in REW when you take the initial measurements and apply 
a 1/6th Octave smoothing to the LEFT Channel. 
 
Repeat the same steps for the Right Channel. 
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Make Curve 2 Active 
 

 
 

 
 
Select 1/6 Octave. 
Place the results in Curve 6 
 

 
 
Compute PSY 
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Uncheck Pulse48R 
 
This is the result of 1/6th Octave smoothing to the Right channel. 

 
 
Make sure Curve 6 is Active 
 

 
 
Save this Curve 
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Name this file R Before 1-6 Oct and Save 
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Turn on these two curves. 
 
L Before 1-6 Oct 
R Before 1-6 Oct 
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Zoom into the Region between 10Hz and 100Hz 
 

 
 
The bass rolls off below 20Hz. 
 
The bass response is uneven between 50Hz and 100Hz. 
 

 
 
This can be easily corrected by Acourate. 
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Select the Region between 100Hz and 1000Hz 
 

 
 
Zoom In 
 

 
 
This needs to be smoothened out. 
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Select the Region between 1000Hz and 14000Hz 
 

 
 
Zoom In 
 

 
 
The measured impulse response of the Left and Right channels above 1kHz is fairly even 
fluctuating within a narrow band of 5dB. You may forego any Digital Correction above 1kHz.  
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Now that you have a fairly good picture of what needs to get addressed, let’s move on the 
Analysis Part. 
 
View the contents of your Project Workspace P1 
 
C:\ACOURATE\P1 
 

 
 
You will run all your analysis on the Measured Impulse Response of the Left and Right Channels.  
 

 Pulse48L 

 Pulse48R 
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Start your Analysis with a clean slate 
 
At the moment you have 6 curves loaded into Acourate. 
 

 
 
Click on the Remove All button. 
 

 
 
You will be asked to confirm every time Acourate removes a curve. 
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Now you have a blank canvas. 
 

 
 
All 6 Curves are empty 
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Select Curve 1 to make it Active 
 

 
 
Load Pulse48L into Curve 1. 
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Select Curve 2 to make it Active 
 

 
 
 
Load Pulse48R into Curve 2. 
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These are the only 2 Curves you need to start your Analysis. 
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Turn on both curves: 
 
Pulse48L 
Pulse48R 
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Check the TIME Chart. 
 

 
 
Select the STEP Response 
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Zoom into this Region 
 

 
 
 
Ideally you would want the Step Response of the Left and Right Channels to be coincident.  
They are not. 
 

 
 
Acourate can fix this. 
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Room Macro 1: Magnitude Preparation 
 
Room > Room Macro 1: Magnitude Preparation 
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Accept all the default values in Room Macro 1. 
 
Your objective is to extract the Minimum Phase Response for the Left and Right Channels.  
 
You are applying a Frequency Dependent Window: 
15 cycles at the Low Frequency 
15 cycles at the High Frequency 
 
Run Macro 1 
 

 
 

 
 
Curve 1 = Pulse48L Minimum Phase Response 
 
Curve 2 = Pulse48R Minimum Phase Response 
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View the contents of Project Workspace P1 
 
C:\ACOURATE\P1 
 

 
 
Acourate has created two new Minimum Phase Response files: 
 

 Pulse48Lmp 

 Pulse48Rmp 
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Room Macro 2: Target Curve Design 
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Move the Blue Target Curve up by dragging the blue handle. 
 

 
 
Ignore a few small dips. 
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You want the blue line to be your Target Curve. 
 

 
 
Digital Correction will be applied only to those frequencies that fall above the Target Curve. 
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Turn on the Subsonic Filter at 15 Hz. 
 

 
 
This will eliminate all frequencies below 15 Hz. 
 
This modifies the Target Curve. 
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The blue Target Curve slopes down sharply at 15 Hz as a result of applying the Subsonic filter.  
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You will not be applying any filtering above 10,000 Hz. 
 

 
 
This will protect your tweeters. 
 
It is never a good idea to boost your tweeters. You can potentially destroy them. 
 
You should let your tweeters naturally roll off. 
 
Note: You will be setting the High Frequency Limits for the Left and Right Channels when you 
enter the parameters for Room Macro 3. You will do this later on Page 145. 
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Save Target 
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Exit 
 

 
 

 
 

 
 
 
Next, you will create Pre Filters for the Left and Right Channels. 
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At the moment you have 3 Curves loaded: 
 
Curve 1 = Pulse48Lmp (Minimum Phase) 
Curve 2 = Pulse48Rmp (Minimum Phase) 
Curve 3 = Target Curve 
 
You are going to replace Curve 1 and 2 with the Measured Impulse Response curves: 
 
Pulse48L 
Pulse48R 
 
Select Curve 1 to make it Active 
 

 
 
Open File 
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Select Pulse48L.dbl 
 

 
 
Open 
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Select Curve 2 to make it Active 
 

 
 
Open File 
 
Select Pulse48R.dbl 
 

 
 
Open 
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Compute Magnitude Difference 
 
FD-Functions > Magnitude Difference 
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Select Source 1 = Target 
 
Select Linear Phase (Default) 
 
Select Source 2 = Pulse48L 
 
Result Curve = Curve 4 
 

 
 
Compute Magnitude Difference 
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Run this operation again for the Right Channel. 
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Select Source 1 = Target 
 
Select Linear Phase (Default) 
 
Select Source 2 = Pulse48R 
 
Result Curve = Curve 5 
 

 
 
Compute Magnitude Difference for the Right Channel. 
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Turn off Curve 1 = Pulse48L 
 
Turn off Curve 2 = Pulse48R 
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Apply Magnitude Limiter 
 
You want to eliminate everything above 0dB 
 
Select Curve 4  
 

 
 
FD-Functions > Magnitude Limiter 
 

 
 
Enter 0dB 
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Select Curve 5 
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Enter 0dB 
 

 
 
 
Everything above 0dB has been eliminated. 
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Define a Region spanning between 80Hz and 200Hz by clicking with your Left and Right mouse 
buttons. 
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Zoom In to this Region 
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Find a spot where both the Left and Right Magnitude Differences are at 0dB. 
Preferably this spot should be below 200Hz if possible. 
Higher the frequency, the more likely your Pre Filters will suffer from Pre-Ringing. 
 
This is the spot under 200Hz where both the Left and Right Magnitude Differences are at 0dB.  
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Zoom in closer to this spot 
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After Zooming In, clear all Markers. 
 

 
 
 
RIGHT CLICK on this spot. 
 
Note: It is important that you use your Right Mouse button. You are defining the Right side of 
your Region. Do not use your Left Mouse button here. 
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Go back to Full Scale View 
 

 
 
 
You have placed a RIGHT Marker (RM) at 174Hz. 
 
You will be discarding everything to the Right of this marker while defining your Pre Filters. 
 
 

 
 
You would apply the Pre Filters to the bass region below 174Hz. 
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Remove Curve 1 = Pulse48L 
 

 
 

 
 
 
 
Remove Curve 2 = Pulse48R 
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Phase Extraction 
 
Select Curve 4 = MagDiff3-1 
 

 
 
TD-Functions > Phase Extraction 
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Click on the Right Marker button [RM]. 
This will populate the Straight Magnitude Above field  
 
Target Phase = Minimum Phase 
 
Place the Result in Curve 1 
 

 
 
Calculate Phase 
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Curve 1 = MinPhas4 
 

 
 



                                                      Using Acourate to Generate FIR Filters 

 
119 

Select Curve 5 = MagDiff3-2 
 

 
 
TD-Functions > Phase Extraction 
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Curve 2 = MinPhas5 
 

 
 
Uncheck Curves 4 and 5 
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Zoom In to this region between 10Hz and 200Hz 
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Select Curve 1 = MinPhas4 
 

 
 
Save this Curve as PreL 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
124 

 
 

 
 
This is your Pre Filter for the LEFT Channel. 
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Select Curve 2 = MinPhas5 
 

 
 
Save this curve as PreR 
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View the contents of your Project Workspace P1 
 
C:\ACOURATE\P1 
 

 
 
 
You have created Pre Filters for your Left and Right Channels. 
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Remove all the Curves and start with a blank slate. 
 

 
 

 
 

 
 

 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
128 

 
 

 
 
 
 
Next, you are going to run through Macros 0 through 5 
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Room Macro 0: Prefilter Definition 
 

 
 
Add your Left Side Pre Filter = PreL 
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Add your Right Side Pre Filter = PreR 
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Your Pre Filters are now active. 
 

 
 
Exit 
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Room Macro 1: Magnitude Preparation 
 

 
 

 
 
Run Macro1 
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Notice how the Bass Region below 174Hz has been smoothened out.  
 

 
 
The Pre Filters have done their job! 
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Room Macro 2: Target Curve Design 
 

 
 
This is your Target Designer Window 
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Drag down the Left Drag Handle so that your blue Target Curve falls below the dips.  
 

 
 
 
 
 
Drag down on the Right Drag Handle to apply a gentle slope above 1000Hz.  
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Save this Target Curve and Exit 
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Clear all Markers 
 

 
 

 
 

 
 
 
Everything above your Target Curve will be corrected. 
 
Everything below your Target Curve will be left alone. 
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Set a High Frequency Limit 
 
Acourate allows you to set a High Frequency Limit to project your Tweeters.  
Everything above this High Frequency Limit will be left alone allowing the Tweeters to naturally 
roll off. 
 
Let’s say you want to set a High Frequency Limit at some point above 10,000 Hz. 
 
Use your Left and Right mouse buttons to define a Region between 10,000 Hz and 24,000 Hz.  
 

 
 
Zoom in to this Region 
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Ideally you want to find a spot above 12,000 Hz where the Left and Right channels cross (have 
the same value). 
 
In this case, the curves almost intersect at Spot A but not quite. There is a slight difference in 
magnitude. 
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The next best approach is to find Spot B and Spot C where the Left and Right Channels intersect 
the brown Target Curve. 
 
Both Spots B and C have the exact same magnitude, although they are at different frequencies. 
This is perfectly fine. 
 
You will choose Spot B to set the High Frequency Limit of the Left Channel in red. 
 
You will choose Spot C to set the High Frequency Limit of the Right Channel in green.  
 
Doing so will ensure the Left and Right correction curves have the same value (no gap between 
the lines) above the Limit Frequencies. 
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Clear All Markers. 
 

 
 
Left Click to place a Left Marker at Spot B. 
 

 
 
You have created a Left Marker at 16,809 Hz 
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Right Click to place a Right Marker at Spot C. 
 

 
 
You have created a Right Marker at 17,974 Hz 
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Room Macro 3: Inversion 
 

 
 
 
Click on the Left Marker button [LM] and the Right Marker button [RM] to set the High 
Frequency Limits. 
 
Select Stereo (default) 
 

 
 
Run Macro3 
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Acourate has created the Inverted Curves. 
 
Pulse48Linv 
Pulse48Rinv 
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To get a better picture, turn off these two curves: 
 
Pulse48Lmp 
Pulse48Rmp 

 
 
You can now clearly see how the Inverted curves look like. 

 
 
Note: The horizontal section above your High Frequency settings signifies that no correction will 
be applied above your set limits. 
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View the Full Scale. 
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Clear Markers 
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You will apply the Inverse Curves to get as close as possible to your Target Curve.  
 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
151 

Turn on all curves to visualize the correlation. 
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View the contents of your Project Workspace P1 
 
You will find the two new Inverse Curves. 
 
C:\ACOURATE\P1 
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Room Macro 4: Filter Generation 
 

 
 
These are the default settings for the ExcessPhase Window. 
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David recommends these settings for the ExcessPhase Window. 
 

 
 
Run Macro4 
 

 
 
Note: Applying this Filter will results in a Filter Insertion Loss of -4.4dB 
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View the contents of your Project Workspace P1. 
 
You will find several new files. 
 
C:\ACOURATE\P1 
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Room Macro 5: Test Convolution 
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You will get this Information Window. 
 

 
 
The Interchannel Cross Correlation has improved slightly over the Original Signals. 
 
ICCC Overall Before = 65.7% 
 
ICCC Overall After = 71.8% 
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You are viewing the Magnitude, Phase and Time of the Test Convolution. 
 

 
 



                                                      Using Acourate to Generate FIR Filters 

 
159 

Take a closer look at Magnitude, Phase and Time. 
 
View Magnitude only. 
 

 
 

 
 
The predicted Frequency Response Curves are looking good. 
 
They will appear smoothened when you apply a Psychoacoustic Filter or a 1/6th Octave 
smoothening. 
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View Phase Only. 
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View Time Only. 
 

 
 



                                                      Using Acourate to Generate FIR Filters 

 
162 

Zoom into this shaded region. 
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This is looking fairly good. 
 

 
 

 
 
Ideally, the Step Response of the Left and Right Channels should be coincident. 
 
This can be addressed by running Macro6. 
 
For now, you will skip Macros6 and Generate the Output Filters to be used in ROON. 
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View the contents of your Project Workspace P1 
You will find a new folder named TestConvolution. 
 
 
C:\ACOURATE\P1\ 
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Open the TestConvolution folder. 
 
C:\ACOURATE\P1\TestConvolution\ 
 

 
 
These are your predicted Impulse Response curves of your Left and Right Channels. 
 
 
 
You can compare them against the measured Impulse Response curves of your Left and Right 
Channels. 
 
Pulse48L.dbl 
Pulse48R.dpl 
 
C:\ACOURATE\P1\ 
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Output the Filters for ROON 
 
Room > Room Macro 4: Filter Generation 
 

 
 
You will be generating Filters for all Sample Rates. Check all boxes. 
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Select Output Format = Acourate for Roon ZIP (WAV+cfg) 
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Run Macro4 
 

 
 
Name this ZIP File = Moab-P1 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
169 

 
 
Note: Using this filter will result in a reduction in gain by -4.4dB 
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View the contents of your Project Workspace P1 
 
C:\ACOURATE\P1 
 

 
 
You have a new folder named Acourate4Roon 
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Examine the contents of the Acourate4Roon folder: 
 
C:\ACOURATE\P1\Acourate4Roon\ 
 

 
 
You will find a ZIP file named Moab-P1.zip. 
 
You will be importing Moab-P1.zip into ROON’s Convolution Engine. 
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Compare the Measured and Predicted Impulse Response Curves 
 
Apply 1/6th Octave smoothing to both the Measured and Predicted Impulse Response Curves.  
 
These are your Measured Impulse Response Curves: 
 
C:\ACOURATE\P1 
 

 
 
You have already applied 1/6th Octave Smoothing to them. 
 

 
 

 
 
 
You will find the Predicted Impulse Response Curves under the TestConvolution folder. 
 
C:\ACOURATE\P1\TestConvolution\ 
 

 
 
Apply 1/6th Octave Smoothing to both. 
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Compare the Measured vs Predicted Impulse Response Curves of the Left Channel. 
 
Tip: Uncheck Auto Scaling of the Y-axis. 
Enter 20 for the upper bound of the Y-axis 
Enter -30 for the lower bound of the Y-axis 
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Compare the Measured vs Predicted Impulse Response Curves of the Right Channel. 
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Here are the Predicted Impulse Response Curves of the Left and Right Channels superimposed 
together. 
 
 

 
 
 
 
Tip: Uncheck Auto Scaling on the Y-axis. 
 
Enter 15 as the upper bound of the Y-axis 
Enter -30 as the lower bound of the Y-axis 
 
You skipped Macro6 during the creation of the output Filters encapsulated in Moab-P1.zip. 
 
Next, you will run Macro6 that will add Time Domain corrections.  
 
This part is optional. 
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Copy Project Workspace P1 to P2 
 
Launch Acourate v3 
 

 
 
Your current Project Workspace is C:\ACOURATE\P1 
 

 
 
File > Copy Actual Workspace Content to a New Workspace 
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Enter new pathname = C:\ACOURATE\P2 
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Examine your file structure: 
 
C:\ACOURATE\ 

 
 
C:\ACOURATE\P2 
 

 
 
This is an exact copy of P1, except Acourate.ini reflecting the new pathnames. 
 
Acourate.ini 
 
[Access] 
LastSaveDir=C:\ACOURATE\P2\ 
[Filter] 
Filter Filename= 
Filter Directory=C:\ACOURATE\P2\ 
[RoomMacro1] 
stereo=1 
psycho=0 
Filename=C:\ACOURATE\P2\Pulse48L 
highFrequencyCut=23000 
FDWlow=15 
FDWhigh=15 
FDWInterpolation=1 
[RoomMacro3] 
Targetname=C:\ACOURATE\P2\Target 
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Room Macro 4: Filter Generation 
 

 
 
Notice, that your Pre Filter is active. Uncheck all frequency boxes except 48kHz. 
 

 
 
Run Macro4 
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Macro 6: Interchannel Phase Alignment 
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Macro6 brings up the Phase View displaying the Group Delay. 
 

 
 
Examine the Curve Legend 
 

 
 
Pay close attention to the trajectory of the Limit Q=10 and Limit Q=60 curves. 
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Your objective is to find peaks that are above Q=10, but below Q=60. 
 

 
 
You are going to work on this Peak on the Left Channel. 
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Zoom In to this region. 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
185 

 
Left Click to Mark the Peak on the Red Curve. 
 

 
 
Get Marked Frequency 
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Demo Edited Values 
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Simulate + Optimize 
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Save Results 
 

 
 
Repeat the same steps using a Peak on the Right Channel. 
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Zoom Out to full scale. 
 
You will work on this Peak on the Right Channel. 
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Zoom In to this Region. 
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Left Click to mark the Peak on the Right Channel. 
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Select Source = Right 
 
Get Marked Frequency 
 

 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
193 

 
 
Simulate + Optimize 
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Save Result 
 

 
 
Move the 2nd result to the Right as it refers to the Right Channel. 
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Zoom Out to Full Scale 
 
Next, you are going to work on another Peak on the Right Channel. 
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Zoom In to this Region 
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Left Click to mark the Peak. 
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Get Marked Frequency 
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Simulate + Optimize 
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Save Result 
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Move the 3rd result to the Right Column as it pertains to the Right Channel.  
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This is your final picture. 
 
You have marked one Peak on the Left Channel. 
You have marked two Peaks on the Right Channel. 
 
All Peaks fall within Q=10, and Q=60 
 

 
 
You are done entering the Parameters for Macro 6 
 
Make sure all 3 are checked. 
 
Exit 
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Room Macro 4: Filter Generation 
 

 
 
 
Notice how the ICPA Filter is now active in addition to the Pre Filter. 
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Run Macro4 
 

 
 
 

Room Macro 5: Test Convolution 
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These are your new ICCC values after running Macro6. 
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View the TIME graph. 
 

 
 
This is looking good. 
 
The Step Responses of the Left and Right Channels match. 
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Zoom In to this Region. 
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The correlation is close enough. 
 

 
 
 

 
 
 
Now you are ready to generated the Output Filters for ROON 
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Room Macro4: Filter Generation 
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Check all Frequency Boxes.  
 
Output Format = Acourate for Roon ZIP (WAV+cfg) 
 
Make sure both your Pre Filter and ICPA Filter are checked. 
 

 
 
Run Macro4 
 
Rename this file 
 

 



                                                      Using Acourate to Generate FIR Filters 

 
213 

New filename = Moab-P2 
 

 
 

 
 
This completes your Acourate Filter Generation exercise. 
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View the contents of:  
 
C:\ACOURATE\P2 
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Open the Acourate4Roon folder: 
 
C:\ACOURATE\P2\Acourate4Roon\ 
 

 
 
You will find a new ZIP file named Moab-P2.zip 
 
 
To summarize: 
 
Moab-P1.zip = FIR Filters for Amplitude Correction. 
 
Moab-P2.zip = FIR Filters for both Amplitude and Time Correction. 
 
You will import both filters into your ROON’s Convolution Engine and save them as Presets: 
 

 Moab-P1 

 Moab-P2 
 
This way you can quickly compare the two. 
 
In the next article you will learn how to import these FIR Filters into ROON. 
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